Operator Manual
Lode Cardiac Rehabilitation Manager

Lode BV
Groningen, The Netherlands
This Operation Manual is not registered for automatic update in case of possible alterations. Information regarding the latest version is available from the manufacturer. This is the Operator Manual for the LCRM Lode Cardiac Rehabilitation Manager. It is valid for following Software Versions: LCRM 1.1.0 and higher.
1 Introduction

Cardiac Rehabilitation
Cardiac rehabilitation is a medically supervised program to help heart patients recover quickly and improve their overall physical, mental and social functioning. The goal is to stabilize, slow or even reverse the progression of cardiovascular disease, thereby reducing the risk of heart disease, another cardiac event or death. Cardiac rehabilitation programs include:

Due to the continuous further development of new diagnostic and therapeutic procedures, a more fundamental change in the rehabilitation of cardiac patients has taken place in the recent past. In this respect, sport therapy has also taken on a very great significance in addition to the stages of early mobilisation and exercise therapy. Under “early mobilisation” is meant the passive and active mobilisation of the patient, as soon as the clinical condition allows.

“Exercise therapy” is exercise which is indicated and prescribed by a physician, planned and administered by special therapists, controlled together with the physician and carried out with the patient either alone or in a group.

“Sport therapy” is therapeutic exercise using suitable sports regimens to compensate and regenerate disturbed physical, emotional and social functions prevent secondary injury and promote health-oriented behavior. It is based on biological laws and includes in particular educational, psychological and socio-therapeutic processes and attempts to achieve lasting health competence.

Ergometer training is used in particular in the areas of early mobilisation and exercise therapy as part of in-patient and also increasingly for out-patient rehabilitation, in order to increase the performance of cardiovascular patients. It has been shown in studies that it is possible to distinctly increase the performance level of patients, even those suffering from heart failure, by the appropriate choice of training form (interval training) and, as a consequence, also the quality of life.

With the LCRM a new modular system for controlled ergometer training is developed. The PC software takes over the entire predefined training control of the patients, documents all relevant data (e.g. ECG, heart rate, training data, etc.) at the same time and so relieves the therapist of routine work – the patients can be taken care of more intensively. Together with the Lode bicycle and treadmill ergometers the LCRM is ready for the future. Modular extensions and upgrade possibilities allow the equipment to be adapted according to increasing requirements (e.g. automatic blood pressure measurements, SPO2).
LCRM – System architecture
The rehabilitation system based on modern PC and software technology considerably simplifies the system architecture. The training ergometers bicycles and/or treadmills are controlled by the PC system, all data are presented on 1 or 2 large flat-screen monitors, depending on the configuration.

Training Devices (optional)
- Bicycle Ergometer Lode Corival (Recumbent and Pediatric)
- Bicycle Ergometer Lode Excalibur Sport
- Arm Ergometer Lode Angio
- Arm Ergometer Lode Brachumera
- Treadmill Ergometer Lode Valiant (Rehab, Pediatric, Plus and Special)
- Treadmill Ergometer Lode Katana

ECG Control
The ECG access points (AP) are receiving the patient’s ECG wire less and continuously, an important requirement for pulse controlled and monitored training. The ECG data is acquired using disposable adhesive electrodes.

Optional Automatic blood pressure measurement
In order to ensure continuous patient blood pressure checks during ergometer training, the bicycle Ergometer can be equipped with a module for automatic measurement. The overall control and timing of the blood pressure measurements (e.g. every 5 minutes) is programmed in the LCRM software, which also documents the measured values at the same time. Additional measurements can, nevertheless, be made at any time – once again, directly at the ergometer.

Optional SPO2 measurement
The optional SPO2 module on the Lode bicycle ergometers can be combined with the LCRM system. The SPO2 can be registered and saved in the Patients record.
2 Installing the Lode Ergometry Manager software

The LCRM is pre-installed on the PC by Lode. If for any reason the installation needs to be replaced please contact your supplier.

Warning: to avoid conflicting software tasks it is not allowed to use other software programs during the exercise test.

2.1 Software serial number

The software serial number can be found in the [Help] menu. This number and the licenses are needed for service.

2.2 Software upgrades

If for any reason a software upgrade or update is required, it will come with instructions.

For more information:

Lode BV
Zernikepark 16, 9747 AN GRONINGEN
The Netherlands
Tel: +31 50 5712811 Fax: +31 50 5716746
E-mail: ask@lode.nl Internet: www.lode.nl
3 Installing the Ergometers

For each individual setting Lode will set up a cable scheme with the customer in order establish the best setting for the situation concerned.

All Lode Ergometers can be used with the Lode Cardiac Rehabilitation Manager (LCRM); bicycle-, recumbent-, arm-, pediatric-, imaging-, and treadmill ergometers. It is not possible however to use the LEM (Lode Ergometry Manager) software modules or the Excalibur Sport with PFM together with the LCRM.

The following steps have to be executed to install the Ergometers with the LCRM properly:

1. Place the ergometers in their operating locations.
2. When one or more control units are not integrated on the ergometer: Place the control unit in its operating location.
3. Connect the RS232 interface cable 930911 between the RS 232 in connector of the ergometer number 1 and a serial port of the PC.
4. Connect the 3 meter ergometer-ergometer cable (928717) between the RS 232 out connector of the ergometer number 1 and the RS 232 in connector of the next ergometer. Connect this last ergometer by the RS 232 out connector with the following ergometer RS232 in connector. Repeat this step until all available ergometers (max licenses or max 8 ergometers for 1 com port) are connected with each other in a loop (see diagram 1)
5. Connect all ergometers to mains.
6. When a Valiant treadmill ergometer is used; a separate RS 232 port must be used for every treadmill to communicate with the software.
7. Ensure that the cables are tied away from any moving parts. Also be sure that the test subject cannot accidentally trip over cables or power cords.
8. If you ordered the heart rate option 911810 and/or blood pressure module as well, make sure that they are properly connected with the help of the supplied manual.
9. Switch on all ergometers
10. Select the [Lode 38K4] communication protocol on the control units (Main Menu > System Parameters > Settings > RS232 Protocol > Lode 38K4 > save settings > Yes) of all ergometers.
11. Select [Terminal] on the control units on all bicycle ergometers.
12. Treadmill Ergometers will automatically go to the desired [Stand By] mode.
13. Refer to the Operator’s Manual for operating the ergometer.
4 Prepare the Exercise Test with LCRM

4.1 Control the Ergometers with the LCRM software

1. The LCRM is pre-installed on the PC. The configuration of ECG licenses with the bicycle and treadmill ergometers is created and tested.
2. For the first installation in the Rehabilitation room, all ergometers should be placed and connected according to the floor plan. To make sure the communication ports are working properly you need to select the [Control] menu in the LCRM software program.

3. Select Ergometers. Make sure the device number in the control unit of the bicycle Ergometer is the same as selected in the Bicycle Settings. All bicycle ergometers must keep their pre-programmed device number. The device number is automatically defined when using a treadmill Ergometer. Press the Test button to check the communication, the software will detect the Device type when the communication is correct. If the program returns with communication failed, please check cables, connections, ergometer type, COM-port, check if the controller is switched on and retry. The Control unit of the ergometer should be active in the [Terminal mode] and connected with cable 930911 with a serial port of the PC.
4.2 Connect the ECG devices

The LCRM is pre-installed on the PC. The configuration of ECG devices combined with the Access Points is installed and checked in the Lode factory.

At first start-up you have to select your ECG Devices from the [Control] menu.

![Control menu]

The following window will appear:

![ECG Devices window]

AP is the Access Point; this is the receiver of the ECG devices. The AP is connected to the PC or network. Every AP can receive the data of 7 ECG devices. The green signal ⬤ is indicating that the ECG device is connected with the AP. The red signal is indicating that the ECG device is trying to make connection, but it is not working yet. The yellow signal indicates an open spot. A new ECG device can only be added to the AP when the correct licenses are purchased.
4.3 Add or Select Test Subjects

Select Subjects from the [Control] menu

In this menu you can add and remove Test Subjects. Relevant information about the Test subject can be written down in this menu.

A default protocol can be selected when this test subject is using this protocol most often. The maximum Heart rate and Blood Pressure levels will trigger the Alarm setting during the rehabilitation.

A short notation can be put in the [Brief Information] field; this information is visible during the rehab session. The reason why this Test Subject is joining the rehab session or a point of attention (warning) for the therapist or operator might be convenient.
4.4 Create Subject Groups

Test Subjects who are going to join different training sessions or days can be placed in Subject groups. Select this menu from the [Control] menu. Add new groups and move Test Subjects from the list to one or more groups. Or move Test Subjects from one group to the other.

Subject Groups can be Removed and Renamed. When you remove a test subject from the group, all data will still be saved in the database.
4.5 Create Exercise Protocols

4.5.1 Protocol Wizard

In the [Control] menu you can program exercise protocols. Select [Protocol Wizard] when you want to create a simple protocol with the help of templates.

Make a choice between a bicycle or a treadmill device and a Steps or Interval protocol. Press Next
Now you can define the amount of steps, the duration, speed and elevation of the low speeds and high speeds Step (Low load and high load Step in case of bicycle ergometer), the recovery and blood pressure settings. Press Finish when you have completed the protocol.

### 4.5.2 Protocol Editor

Select the menu [Protocols] from the list when you want to edit or create a specific exercise protocol.

The *Protocol editor* will appear, with a list of the programmed exercise protocols. When you press *Add Protocol* you can make a choice between a bicycle or treadmill protocol.
The text "<Unknown>" appears in the list of protocols. When you fill in a name for the exercise protocol in the right side of this Protocol Editor and press the [OK] button, the protocol name will appear in the list. Protocols with a sign have stages already. New protocols are mentioned in the list by name without the sign.

In the example above the name of the protocol is [Cardiac rehab demo]. By pressing the [Add Stage] menu you can make a choice between a Step, Ramp, Heart rate Controlled or a Recovery stage.

### 4.5.3 Step Protocol

In Cardiac Rehabilitation the most commonly used protocol is a stepwise Interval protocol. These protocols can be created and customized very easy with the LCRM Software. Pressing [Step] will show you the following screen.
You can enter the number of steps and define the step length of the low and high workload step. You can Add other stages or the Recovery stage until the protocol is fine, press OK. In the above example (Cardiac rehab demo) the protocols starts with a 15 Watt step, followed by a ramp from 15 up to 25 Watt. The step in progress is named automatically Step (25-60 Watt), the next step normally would be the recovery stage. Scrolling through the stages on the right side will give you the possibility to adjust a particular stage.

Keep in mind for programming the speed in treadmill protocols the software will accept steps smaller then 1 km/h when you use the notation (a dot or a comma) as defined by the language selecting of the windows version you are working with (0,1 or 0.1)
In this example the 3th stage of the protocol [rehab 4-8 km/h] is just defined. In this stage the elevation (green line in graph) is adjusted.

### 4.5.4 Heart rate controlled Protocol

A Heart rate controlled stage can be programmed as a part of a stepwise protocol or programmed as a Heart rate controlled protocol itself. When you create a Heart rate controlled stage or protocol for the bicycle or treadmill Ergometer, it is possible to define the Target heart rate and at the same time the maximum Workload (bicycle) or maximum Speed and Elevation (treadmill) for safety reasons.
4.6 Device Setup

The device setup of LCRM is pre-installed. Every available slot on the screens of the LCRM system is assigned to an exercise device and to an ECG device.
By selecting an empty place < No ECG Device / Ergometer / protocol > a pop-up appears with the selectable items. In the above example, slot 5 has no ECG device and no Ergometer. For normal use the Device set up should not be changed!

4.7 Electrode Placement

Proper electrode placement is essential in order to acquire accurate ECG strips. The following are some general guidelines.

- Skin preparation:
  - Remove hair from electrode placement site.
  - Rub site briskly with alcohol pad.
  - Rub site with 2x2 gauze.
  - Place electrode. Be sure that the electrode has adequate gel and is not dry.

- 3 lead placement:
  - Depolarization wave moving toward a positive lead will be upright.
  - Depolarization wave moving toward a negative lead will inverted.
  - Depolarization wave moving between negative and positive leads will have both upright and inverted components.

Lead II is the same as standard lead two as seen in a 12 lead EKG. It is the most common monitoring lead.
With the Lode LCRM system you can choose between lead I (an electrode positioned on the left arm) or lead II (an electrode positioned on the left leg). The placement and color coding (USA or European) is schematically drawn on the ECG box label.

All possibilities are schematically drawn in this figure.

For separate lead placement of lead I and lead II see the European and American coding in the figures below. Starting with the European lead II and I, the last two figures are representing the American colors for lead II and I.
**Trouble shooting and tips**

- Change the electrodes everyday.
- Make sure all electrical patient care equipment is grounded.
- Be sure all the lead cables are intact.
- Be sure the patient's skin is clean and dry.
- Make sure the leads are connected tightly to the electrodes.

**Warning:** Make sure the blue tooth connection of mobile phones is turned off
5 Perform the rehabilitation tests

5.5.1 Check Battery

You have to check the battery status with the battery indicator in front of every slot.

A green battery shows you the communication is good. You should not start the Rehab session with a low battery warning. For replacement and specifications of batteries see chapter 8.

5.5.2 Assign Test Subject/ groups and protocol

When everything is prepared properly the Test Subjects and Protocols can be assigned to an ECG slot. Press [Setup]:

Activate the slot you want to use by a click with the mouse in the slot. A list of Test Subjects will appear when you press the < No Subject> field. A test Subject with a default selected protocol will come up with the default protocol. This protocol can be changed when needed by selecting that field.

In the example above for the first slot [Stephan Nicolson] and the [rehab 25-50 watt] protocol are selected. You can use the search field to look for the Test Subject or select the name of the Test Subject and protocol in the lists at the right side of the display.

To assign a Subject Group you have to select the [Subject Group] menu, a pop-up menu will appear as you can see in the figure below.
A protocol can be assigned afterwards when it was not selected as default or not compatible with the Ergometer device.

In the example above the Test Subject [Julius VanderBilt] needs to use a treadmill protocol in this session. A treadmill is assigned to this ECG slot, so bicycle ergometer protocols will not be available for this slot.

When all Test Subjects do have an ECG signal and a protocol, you can select the [Ergometers] menu to control the exercise protocols during the training.
5.5.3 Start the rehabilitation sessions

To start the training sessions one by one or all at the same time you press the green arrows.

Automatically the protocol will go to the next Stages when you want to go to the Next or previous stage at another time you can press the buttons of the figure below:

With you can go to the next stage.

By pressing you will go to the previous stage again.

To pause the session you can press.

To go to the Recovery stage press.

When the total group has to go to the recovery stage press the button.

When the Recovery stage is finished you can stop the test of one Test subject by pressing or the total group by pressing.

Now you have to decide if you want to save the session data with the buttons or save all tests of this session, buttons.

Or clear the data of this test subject with the [clear] button or all tests of this session with [clear all].

During the training the ECG will always stay at the left side of the display and on the right side you can choose what you want to see.
5.5.4 The Ergometer menu

When the [Ergometers] menu is selected you can adjust the protocols during the training with the buttons at the right side of the protocol graph (Load, Speed, Elevation, Target HR). At the left side of the protocol graph you will find the Blood Pressure, current Heart rate, time, remaining time of the stage and the Mark button.

5.5.5 The ECG Menu

During the session you can have a better look at the ECG of the selected (active in blue) Test subject by pressing the [ECG] menu.
An ECG screen will appear on the right side of the monitor, the running ECG’s will always be visible at the left side of the monitor. You can scroll through the ECG from marker to marker with the \( \text{buttons}. You can update the ECG or choose to auto-update with the running data.

In this menu you can print the ECG as shown on the right side of the screen of this test subject as well. See 0 Tools to define the printer settings.
During the session you can compare the actual ECG data and protocol with previous tests of the same test Subject. Go to extra and select the desired test data of the test subject. When you have loaded the selected test you can see the results in the Analysis or Comparison menu.
6 Analyzing the exercise test

6.1 The Extra Menu

After the training session you can compare and analyse the data. Select the Test subject you want to analyse in the [Setup] menu. Select the [Extra] menu. The following will appear:

Now you can select and load the primary and secondary test to make a comparison or analyses

6.2 The Comparison Menu

By pressing the [comparison] menu

The selected tests will be shown as followed:
The 2 graphs will appear and a table with a summary of the session and the difference between them (can be presented in relative values as well by ticking the box in the left corner).

6.3 The Analysis Menu

By selecting the [Analysis] menu the primary test will be presented with the ECG signals and test data. You can scroll from marker to marker with the buttons. The time and place of the marker is shown in the ECG graph in blue.
Julius Vanderbilt

745974

Scale
1,00 mV/cm

<No Protocol> 6-7-2010 15:01

0:26

0:30
7 Menu Functions

7.1 File
With the File menu you can exit the LCRM program

7.2 Tools
Select Tools from the toolbar and you will find the menu’s Setting and Authorisation. Setting is a LCRM tool for the ECG Device, Printer and database customized settings.
In [Settings] the menu [language] will give you the opportunity to select another language as a default setting.

or in the French language
The menu [authorisation] will show you the software serial number, amount of slots and license information.

With the [Window] menu you can open the primary and secondary Window for the slots 1-8 and slots 9-16.
8 Battery Replacement

When the battery status is turning red you have to replace the 2 batteries in the ECG device. It is not possible to use rechargeable batteries. Lift the battery cover at the back side, replace the empty batteries by 2 new ones.